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Preface
This user manual describes the Smart Flash Programmer (SFP) for automating 
programming of Flash devices in targets having microcontrollers like Z8 Encore!® or 
eZ80Acclaim!®.

Manual Organization 

This manual is divided into the following chapters:

Chapter 1 – Using the Smart Flash Programmer (SFP)

This chapter describes the SFP features, tool requirements, supported operating systems, 
supported host system configuration, and software installation.

Chapter 2 – Understanding the SFP GUI

This chapter describes SFP graphical user interface and explains in detail, the menu bar, 
the toolbar, information window, workspace and configuration window, project tab 
description, target tab description, project and target options, and status window.

Chapter 3 – Configuration

This chapter describes the procedure for creating a new project and target device.

Chapter 4 – Programming Flash Memory

This chapter describes a Flash programming workflow and procedure for the following on 
an attached target:

• Program Flash. 

• Fast program Flash. 

• Verify program stored in Flash. 

• Erase Flash. 

• Program single value in Flash.

Chapter 5 – Advanced Configuration

This chapter describes the advanced configuration window and procedure for calculating 
the file and Flash checksum, specifies Flash files to be programmed, and procedure for 
managing targets. 

Chapter 6 – SFP Command Line and Scripting Feature

This chapter describes the process for starting SFP from command prompt and explains 
the supported script file commands, project related commands, setting up Flash options, 
UM020001-0406 Preface
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target related commands, communication settings, command execution, error handling, 
and other miscellaneous commands. 

Conventions 

The following conventions are used in this manual:

italics

Expressions in italics indicate variables to be replaced by specific values. For example, the 
statement: watch <identifier>, requires you to substitute a value for <identifier>.

Bold

Window names, menu commands and button names are bold to make them stand out in the 
text. Likewise, bold is used to denote the command that you are executing, for example: 
(Press OK).

Courier

Courier is used for code, directory, and file names.

Additional Information 

Before you use the technical support provided on the web page, refer the following 
documentation:

• Readme.txt File

Refer to Readme.txt file available in the <ZILOGINSTALL>\SFP_<version> for SFP 
installation tips.

where

ZILOGINSTALL is the SFP installation directory. 

version is the SFP version number like 2.0.

The default installation directory is C:\Program Files\ZiLOG

• Quick Start Guide 

Quick start guide (QS0058).

ZiLOG Technical Support

For technical questions related to ZiLOG products and tools or for design assistance, visit 
our  website: http://www.zilog.com.
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You must provide the following information in your support ticket:

• Product release version (using the About toolbar icon).

• Type of hardware you are using.

• Exact wording of any error or warning messages.

• Any applicable files attached to the e-mail.

Supported ZiLOG Parts  

The following steps helps you to find out the supported ZiLOG parts:

1. From the File menu, select New project.

The Project Creation window (Figure 54) is displayed.

2. In the Project Creation window, the CPU Family Group, CPU Family, and CPU 
drop-down list boxes display the supported ZiLOG parts.

Readme.txt file also provides the list of supported ZiLOG parts.

Figure 54. Project Creation Window
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Chapter 1
Using the Smart Flash Programmer (SFP)

This chapter describes the SFP under the following topics:

• Introduction 

• Features of SFP 

• Tool Requirements 

• Supported Operating Systems 

• System Requirements 

• Software Installation 
UM020001-0406 Using the Smart Flash Programmer (SFP)
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Introduction 

The SFP is a software tool used to automate programming of Flash devices in targets 
having microcontrollers like Z8 Encore!® or eZ80Acclaim!®.

Use the SFP’s Advance Configuration interface to create Flash project files. These project 
files store the configuration settings needed to burn the Flash memory on a specific target.

Once a project is configured, the SFP interface can be used to automate Flash memory 
programming.

This user manual provides instructions that support:

• SFP Configuration (see Chapter 3 on page 35 for more details).

• Using SFP (see Chapter 4 on page 47 for operation instructions).

Features of SFP

The following list provides a brief overview of SFP features:

• Windows-based software Flash programming tool.

• Easy-to-use GUI.

• Two end-user configurations:
– Simplified (on step programming).
– Advanced (for advance SFP configuration).

• Supports Program and Verify and Fast Program modes.

• Calculates hex File checksum and Flash checksum.

• Allows you to set-up serialization for programming a Flash memory location with a 
unique number over a range of values:
– Supports incremental serialization.
– Supports hex, decimal, IP, and MAC serialization values.

• Enables multiple hex file programming.

• Uses hex files produced by ZiLOG’s ZDS II IDE.

• Programs the attached targets through the ZiLOG debug interface. It requires use of a 
serial Smart Cable or USB Smart Cable or Ethernet ZPAK (eZ80Acclaim!®).

• Allows you to Flash multiple targets sequentially over Ethernet ZPAK 
(eZ80Acclaim!®) and USB cables (eZ80Acclaim!® and Z8 Encore!®).

• Supports scripting and automation. Script commands can be used to automate the 
execution of a significant portion of the application.
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• Supports different Flash devices like Atmel, Micron, STMicro, Intel, and AMD for 
eZ80Acclaim!®.

Tool Requirements

The following sections describes the tool requirements for Z8 Encore!® and 
eZ80Acclaim!® family of microcontrollers.

Requirement for Z8 Encore!® Families

Z8 Encore!® family of microcontrollers requires one of the following Smart Cable for 
connecting the PC to a target board:

• Z8 Encore!® Serial Smart Cable.

• ZiLOG® USB Smart Cable. 

• USB hub for multiple target programming.

Requirement for eZ80Acclaim!® Families

eZ80Acclaim!® family of microcontrollers requires one of the following cables for 
connecting the PC to a target board:

• ZPAK II with CAT5 Ethernet Cable.

• eZ80Acclaim!® Serial Smart Cable.

• ZiLOG® USB Smart Cable.

Supported Operating Systems

SFP supports the following operating systems:

• MS Windows 98SE.

• Windows NT 4.0 SP6(Serial and Ethernet only).

• Windows 2000 SP4.

• Windows XP Pro.
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System Requirements

The following section describes the recommended and minimum configuration for SFP. 

Recommended Configuration

The recommended configuration for SFP is listed below: 

• Operating system - MS Windows XP Pro.

• Pentium III/500 MHz processor or higher.

• 128 MB RAM or more.

• 25 MB hard disk space (includes both application and documentation).

• Super VGA video adapter.

• CD-ROM drive. 

• Ethernet port. 

• High-speed USB port (when using USB Smart Cable).

• RS232 communication port with hardware flow control.

• Internet Explorer 6.0 or Netscape (HTML Help 1.1 or later). 

Minimum Configuration

The minimum configuration for SFP is listed below:

• Operating system - MS Windows 98 SE.

• Pentium II 233 MHz processor.

• 96 MB RAM.

• 25 MB hard disk space (includes both application and documentation).

• Super VGA video adapter.

• CD-ROM drive.

• Ethernet port.

• RS232 communication port with hardware flow control.

• Internet Explorer 6.0 or Netscape (HTML Help 1.1 or later). 
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Software Installation

You can install SFP either from the CD-ROM provided by ZiLOG or download from 
ZiLOG website http://www.zilog.com. 

The following steps helps to install SFP:

1. Double-click the installation file if you have downloaded SFP from ZiLOG website or 
use the menu option Install SFP if installing from CD-ROM and follow the on-screen 
instructions.

2. In the Licence Agreement window, click Yes to accept the agreement. 

3. In the Choose Destination Location window, click Next.

Figure 55. Choose Destination Location Window

By default, the software is installed in the following path:
C:\Program Files\ZiLOG\SFP_<version>

4. In the Select Program Folder window, click Next to install in the default location:

Start menu>Programs > ZiLOG Smart Flash Programmer <version>
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Chapter 2
Understanding the SFP GUI

This chapter describes the SFP GUI under the following topics:

• SFP GUI

• Menu Bar

• Toolbar

• Information Window

• Configuring Workspace

• Project Tab

• Target Tab

• Status Window
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SFP GUI

SFP graphical user interface consists of a menu bar, toolbar, information window, 
workspace window, configuration window, and status window (see Figure 56).

Figure 56. SFP Graphical User Interface
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Menu Bar 

The menu bar consists of the following menus: File, View, Flash, Target, and Help as 
shown in Figure 57.

Figure 57.  Menu Bar

Table 1 describes the Menu Bar.

Table 1. Menu Bar Description 

Menu Name Menu Description

File Use the File menu to create, 
open, or save a project. You can 
set log option, clear log file and 
status window, run script file, 
and also view the 
recent projects.

View Use the View menu to show or 
hide the Advance Configuration 
window and to customize the 
display of toolbar icons and 
labels.
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Toolbar

Figure 58 displays the SFP Toolbar buttons and Table 2 describes the Toolbar buttons.

Figure 58. Toolbar

Flash Use the Flash menu to perform 
the following flash operations: 
Program/Verify, Fast Program, 
Verify, Erase, Program Single 
Value, Calculate File and Flash 
Checksum.

Target Use Target menu to create, 
save, and manage targets.

Help Use the Help menu to list the 
help topics, context-sensitive 
help, and general information 
about the software.

Table 1. Menu Bar Description (Continued)

Menu Name Menu Description
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Table 2. Toolbar Description  

Toolbar Name Button Description 

Program/Verify Programs and verifies the target/targets sequentially. 

Fast Program Programs the target/targets sequentially without 
verification. 

Verify Verifies the program stored in Flash on an attached 
target/targets sequentially.

Erase Erases the program stored in Flash on an attached 
target/targets sequentially. 

Single Value Programs a single value in Flash on an attached 
target/targets sequentially.

File Checksum Calculates the checksum for a specific hex file.

Flash 
Checksum

Calculates the checksum for the Flash devices 
connected to the target.
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Information Window 

Figure 59 displays the Information window. 

Figure 59. Information Window

The Information window displays the following:

• Target Name.

• File Name. 

• Active Communication Type.

• File Offset Value.

• Erase Before Program indicates whether erase before program option is enabled or 
disabled.

• Include Serial Number indicates whether serial number is included or not.

Help Topics Displays the help topics. 

About Provides general information about the software like 
version number and the components installed. 

What’s this? Displays a popup window with the text describing the 
control and what it is for.

Table 2. Toolbar Description  (Continued)

Toolbar Name Button Description 
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• Advance Configuration button for displaying/hiding the Workspace and 
Configuration windows. Displaying/hiding menu items available for advance mode 
only. 

Configuring Workspace

Figure 60 displays the Workspace window. 

Figure 60. Workspace Window

The Workspace window and Configuration window are displayed only when the 
Advanced Configuration button on the Information window (see Figure 59) is clicked. 

For each link selected on the Workspace window, the corresponding details of that link 
will be displayed on the Configuration window. The following sections describes in 
detail, the different Configuration windows for each of the link selected on the 
Workspace window. See Figure 56 for different windows of SFP. 

              Project Tab             Target Tab
UM020001-0406 Understanding the SFP GUI



Smart Flash Programmer
User Manual

18
The SFP Workspace window (see Figure 60) consists of two tabs: 

• Project tab 

• Target tab

Project Tab

The Project tab allows you to view and/or change the following window details:

• Flash Details

• Flash Files

• Settings

• Communication

• Serialization

The following sections describes in detail, the various windows under the Project tab.

Flash Details Window

Click the project name under the Project tab in the Workspace window, the 
corresponding Configuration window – Flash Details window (see Figure 61) is 
displayed.

The Flash Details (see Figure 61) window provides a summary of project details like, the 
CPU family, selected Flash files, whether Flash memory will be erased before 
programming or not, file offset, whether to include the serial number with programming or 
not, serialization address, serialization number, serialization size in bytes, serialization 
increment, and communication settings. 

The project details: Erase Info Page and Use Info Page with Serialization will be displayed 
only for eZ80Acclaim!® microcontrollers. 

Right-click on the Flash Details window (see Figure 61) allows you to copy selected text 
or to select all text in the Flash Details window.

Note:
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Figure 61. Example For Configuration Window –The Flash Details Window

Flash Files Window 

Click the Flash Files link under the Project tab in the Workspace window, the 
corresponding Configuration window – Flash Files window (see Figure 62) is displayed.

Figure 62. Flash Files Window
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The Flash Files window lists the Flash files in the order that they will be programmed. It 
includes the following buttons:

• Add button will navigate to the location of a Flash file to be programmed.

• Remove button will remove the selected Flash file from the Flash File window.

• Remove All button will remove all the Flash files from the Flash File window.

• Up and Down buttons are used for re-arranging the programming order of the Flash 
files.

Right-click on a file link in the Flash Files window (see Figure 62) will display the 
Option menu to calculate the File checksum. Selecting the File Checksum option will 
invoke the File Checksum Calculator dialog box (see Figure 63) to calculate the 
checksum for the selected file. 

                        

Figure 63. File Checksum Calculator

Settings Window

Click Settings link under the Project tab in the Workspace window, the corresponding 
Configuration window – Settings window (see Figure 64) is displayed.

The Settings window includes the following configurations: 

1. In the File Offset (Hex) text box, enter a hexadecimal file offset value. This value 
applies to every file in the project’s Flash files list.

2. If you want to erase the Flash memory range defined in your target settings before 
programming, select the Erase Before Programming check-box.

3. If you want to preserve the Flash memory Info page when the target device is erased, 
Select the Do NOT Erase Info Page check-box.

 Do NOT Erase Info Page option is available only for eZ80Acclaim!® microcontrollers.Note :
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Figure 64. Example for Settings Window – eZ80Acclaim!®

4. For error handling, you can set any one of the following options:
– Continue Flash operations – Select this option to continue the Flash operation 

on the next target when an error is encountered. 
– Stop Flash operations – Select this option to stop the Flash operation when an 

error is encountered. 
– Ask for confirmation before continue – Select this option to ask for 

confirmation before continuing Flash operations on the next target.

• The above error handling options for multiple target programming are available when 
using the USB Smart Cable and/or while using eZ80Acclaim!® ZPAK II. Serial Smart 
Cables do not support multiple target programming.

• The above error handling options are not available during the execution of scripts. If 
an error is encountered during execution of scripts, SFP continues with the default 
option of continuing the Flash operation on the next target. 

5. Auto Close Flash Operation Window – Select this option to close the Flash 
operation windows (see Figure 36, Figure 37, and Figure 40 )automatically after the 
Flash operation is complete. The status of the Flash operation will be indicated in the 
Status window.

Notes :
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Communications Window

Click the Communications link under Project tab in the Workspace window, the 
corresponding Configuration window – Communication window (see Figure 65 through 
Figure 67) is displayed.

SFP supports three debug tools (Serial, USB, and Ethernet) for communication. 
Depending on the debug tool selected in the Type drop-down list on the Communication 
window, the other fields are displayed accordingly as shown below. 

• When communication type is serial, Communication window (see Figure 65) will 
have the following fields. 
– Port: You can select the required port from the Port drop-down list.
– Baud Rate: You can select the required baud rate from the Baud Rate drop-down 

list.

Figure 65. Serial Communication Type 

• When the communication type is USB, SFP scans all the USB ports on the PC to 
detect all USB Smart Cables and then lists their serial numbers in the Serial Number 
pane as shown in Figure 66.
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Figure 66. USB Communication Type 

 The Communication window (see Figure 66) provides the following options:
– You can change the order of connecting the USB devices using the Up and Down 

buttons.
– Use the Refresh button to re-scan the USB ports.

• When the communication type selected is Ethernet, SFP displays a list of IP addresses 
and the port number as shown in Figure 67. You can select/deselect the check-boxes 
preceeding the IP address to include/exclude the IP address in the project for Flash 
operations. New IP addresses are added to the list with the Add function.

SFP reads the IP addresses from the <installation_dir>/debug tool/ <prod-
uct>/directory and lists all the IP address and port numbers that have been added.

For more information on the debug tools (see Appendix A: Files Used by SFP on page 89). 

Note:
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Figure 67. Ethernet Communication Type 

The Communication window (see Figure 67) provides the following options:
– Add IP Address

Enter the IP address to to be added in the IP Address text box, and the TCP port 
number in the TCP Port text box, and click Add. By default, the added IP address is 
selected in the IP address list. 
– Delete IP Address

To delete a particular IP address from the IP address list, select the IP address, and 
click Delete. To delete all the IP addresses from the IP address list, select all the IP 
address, and click Delete All.

Deleting an IP address will also delete the corresponding debug tool files from the 
<installation_dir>/debug tools/<product>/ directory. The deleted              
IP address will no longer be available for other projects.

– Edit IP Address

To edit an IP address, select the IP address from the IP address list, and click Edit. In 
the Edit IP Address and TCP Port dialog box (see Figure 68), edit the values, and 
click OK.

Note:
Understanding the SFP GUI UM020001-0406



Smart Flash Programmer
User Manual

25
The Edit IP Address and TCP Port dialog box (see Figure 68) can also be opened by 
double-clicking the IP address from the IP address list. 

To select an IP address, click the corresponding check-box proceeding the IP address 
in the IP address list.

  

Figure 68. Edit IP Address and TCP Port

– Rearrange the IP Address list

You can rearrange the order of using the IP address using the Up and Down 
buttons.The order of IP address determines the order of Flash operations.

You have the option to use the alternate ZDI clock frequency. This option is available 
only for the eZ80Acclaim!® microcontrollers.

Serialization Window

Serialization is the ability to store customer identifier information such as a serial number 
or internet address into the Flash memory.You can program unique values into Flash, or 
set an initial value and uniformly increment it. Serialization is a useful tool and is not 
required to program Flash. 

Click the Serialization link under the Project tab of the Workspace window, the 
corresponding Configuration window – Serialization window (see Figure 69 through 
Figure 71) is displayed.

Based on your selection of the target device in the Target window and the communication 
type in the Communication window, the Serialization window will have different 
settings as shown below.

• If the target device is eZ80F91 with serial communication selected, the Serialization 
window (see Figure 69) will have the following settings:
– To enable serialization, select the Include Serialization in Programming check-

box. When this option is selected, SFP calculates the serialization value and writes 
that value at the specified location during Flash programming of the hex file. 

Note:

Note:
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Figure 69. Serialization Settings for Serial Communication

For eZ80Acclaim!® CPU family, if you want the serialization value to be stored in the 
Flash memory Info page, select the Place in Info Page check-box. For Z8 Encore!® 
family of products that support non-volatile data storage (NVDS) the option for using the 
NVDS can be selected for serialization value storage. 

– In the Address (Hex) text box, you can enter the Flash memory address where 
you want  the serialization code to be programmed.

– In the Size in Bytes drop-down list, select the number of bytes required to store 
the serialized entry. The sizes available depend on the serialization value display 
format.

– In the Serialization Value text box, you can enter a unique serial number or a 
starting value for sequential serialization.

– In the Serialization Value section, you can select a radio button to determine how 
you want the value to be entered and displayed. The options are:

–  Hexadecimal

–  Decimal

–  IP Address: Four dotted decimal octets, for example 192.168.1.30.

Note:
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–  Media Access Control (MAC): Six hexadecimal bytes separated by colons,   
for example 00:90:23:1C:45:1B.

Regardless of the display format, serialization values are always stored as a binary 
value of the specified size.
– In the Increment setting section, enter an increment value for the serialization 

value to be incremented after programming each target. The increment value can 
be either an hexadecimal or an decimal value.  

– If you have a target device attached to your host PC, you can click Read Serial to 
read the serial number currently stored in that device.

– If you want to program unique values into the individual parts, you can click 
Program Serial to program the current serialization value into the Flash memory 
of the currently attached target.

The serialization bytes in Flash memory must be blank (all FFH) for the Program Serial to 
succeed. If an hex file is stored, it should include a blank space for the serial number.

If the communication type selected is USB/Ethernet, the Serialization window (see 
Figure 70 and Figure 71) displays all the targets selected for programming. These targets 
are selected by the user in the Communication window (see Figure 66 and Figure 67). 
SFP automatically calculates the serialization values for all the targets based on the 
serialization value and the increment settings. 

• If the USB type of communication is selected in the Communication window (see 
Figure 66), the Serialization window (see Figure 70) will have all the settings 
configured for serial communication, and in addition, it also includes the USB Serial 
Number pane as shown in Figure 70. The serial number of the USB devices 
connected will be displayed in the USB Serial Number pane. 

Note:
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Figure 70. Serialization Settings for USB Communication

• If the Ethernet type of communication is selected in the Communication window (see 
Figure 67), the Serialization window (see Figure 71) will have all the settings 
configured for serial communication and in addition, it also includes the IP Address 
list as shown in Figure 71. 
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Figure 71. Serialization Settings for Ethernet Communication

Target Tab

The Target tab allows you to view and change the following window details:

• Target Details.

• Memory (available only for eZ80Acclaim!® CPU families).

• Flash Memory (available only for eZ80Acclaim!® CPU families).

• Clock.

Target Details Window

Click the target name under the Target tab in the Workspace window, the corresponding 
Configuration window – Target Details window (see Figure 72) is displayed.

The Target Details window provides a summary of target details like the Name of the 
Target, CPU Family, CPU Name, and Clock Frequency. 

For eZ80Acclaim!® families, the Target Details window will also display the External 
Flash Manufacturer, External Flash Device, External Flash Base Address, and External 
Flash Units. 

Note:
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Figure 72. Target Details Window

Clock Window

Click the Clock link under the Target tab of the Workspace window, the corresponding 
Configuration window – Clock window (see Figure 73, Figure 74) will be displayed.

In the Clock window for eZ80Acclaim!® (see Figure 73), enter the frequency in the 
System Clock Frequency (Hz) text box.

Figure 73. Clock Window for eZ80Acclaim!®

In the Clock window for Z8 Encore!® (see Figure 74), select the clock source radio button 
Internal or External in the Clock Source pane and select/enter the clock frequency in the 
Clock Frequency (MHz) pane.

Figure 74. Clock Window for Z8 Encore!®
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Memory Window

Click the Memory link under the Target tab of the Workspace window, the 
corresponding Configuration window – Memory window (see Figure 75) will be 
displayed.

Figure 75. Memory Window

The SFP writes the initialization parameters to the target while the connection is being 
established. This allows for a virtual reset condition to be created using the following:

1. On the Memory window (see Figure 75), in the External Memory/IO section, you 
can configure the following settings:
– Select a chip select register (CS) from the Chip Select Register drop-down 

list.The chip select registers control the type of access, address bounds, and wait 
state assertion.

– Enter the lower bound for the chip select register in the Lower Bound (hex) text 
box.

– Enter the upper bound for the chip select register in the Upper Bound (hex) text 
box.

– Enter the control register value in the Control Register (hex) text box.
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– Enter the bus mode in the Bus Mode (hex) text box.
– Enter the external RAM address range in the RAM Address Range text box. SFP 

uses this external RAM address to download the Flash agent during Flash 
programming and requires approximately 4 K of memory space to run.

2. On the Memory window (see Figure 75), in the Internal Memory section, you can 
configure the following settings:
– Select the Enable Data RAM check-box (eZ80Acclaim!®) to enable the general-

purpose internal RAM block. Enter the address in the Address Upper Byte (hex) 
field. The Data RAM will be mapped to the top of the selected 64 KB block. 

– Select the Enable EMAC RAM check-box (eZ80Acclaim!®) to enable the 
Ethernet Media Access Controller’s internal RAM (eZ80Acclaim!® F91 only). 

Flash Memory Window

Click the Flash Memory link under the Target tab of the Workspace window, the 
corresponding Configuration window – Flash Memory window (see Figure 76) will be 
displayed.

The Flash Memory window (see Figure 76) allows you to check the Flash memory map. 
The eZ80Acclaim!® family requires a Refresh to populate the Flash information. Flash 
memory map displays the actual memory map of the selected Flash memory device with 
the following details:

• Address Range –These address ranges are determined by the selected Flash memory 
device.

• Type of Flash corresponding to the address (internal/external).

• Chip select register (CS) selected in case of external flash.     

• In the Flash Memory Map pane, select the pages to include in Flash operation. The 
pages that appear in gray are not available for selection. To select/deselect all the 
pages, right-click the Flash Memory Map pane to display the select all/deselect all 
option.
Understanding the SFP GUI UM020001-0406



Smart Flash Programmer
User Manual

33
Figure 76. Flash Memory Window

You can configure the following settings on the Flash Memory window:

• If you want to use internal Flash memory, select the Use Internal Flash check-box 
(eZ80Acclaim!®).

• If you are want to use external Flash memory, expand the Flash device tree in the 
External Flash Memory pane and select the appropriate Flash memory device that 
you want to program and configure the following settings:
– Specify the external Flash base address in hex value in the External Flash Base 

Address(Hex) text box.
– Select the number of units from the Number of Units drop-down list.

Project and Target Options

Right-click on the project workspace window provides the following menu options:

• New Project

• Open Project

• Save Project

• Save As Project
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Right-click on the target workspace window provides the following menu options:

• New Target

• Save Target

• Manage Targets

Status Window

The Status window displays basic information about your actions, error, and warning 
messages as shown in Figure 77. You can clear the Status window by selecting Clear 
status window from the File menu.

Figure 77. Status Window
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Chapter 3
Configuration

This chapter describes configuration under the following topics:

• Introduction

• Create a New Project

• Create a Target Device 
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Introduction

SFP settings are stored in project files. Create a project file and configure the project to 
support Flash memory programming for a specific target (eZ80Acclaim!® or Z8 Encore!® ).

Create a New Project 

Once the SFP is installed, the Project File Selection window (see Figure 78) is displayed. 

Project File Selection window will be displayed only for the first time after installation.

Figure 78. Project File Selection Window

1. If you have already created projects, you can click the Browse link to locate the 
project.

2. To create a new project click New in the Project File Selection window (see 
Figure 78). The Project Creation window is displayed (see Figure 79).

If the Project Creation window is not displayed, enable the advance settings by clicking 
the Advanced Configuration button on the Information window (see Figure 59) and 
then select New Project from the File menu to create a new project.

3. In the Project Creation window (see Figure 79), click the browse button  to 
locate the project file. 

You can also type the path and file name for the new project directly into the Project 
File text box and move to step 8. Select the File window is displayed (see Figure 80).

Note:

Note:
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Figure 79. Project Creation Window

4. In the Select the File window (see Figure 80), select the folder in which you want to 
save the new project. 

5. In the File name text box, enter a file name for the new project. Use legitimate 
windows filename. Do not enter any extension. The default extension of the project 
file is:.zfpproj.

6. Click Save to close the Select the File window.

The Project File text box in the Project Creation window (see Figure 79) will 
display the path along with the file name.

7. In the Project Creation window (see Figure 79), select the CPU family group from 
the CPU Family Group drop-down list.

8. Select the CPU family from the CPU Family drop-down list.

9. Select the CPU from the CPU drop-down list.

10. In the Target Selection list, select the required target, if available in the list or create a 
new target as per the steps given in section Create a Target Device on page 39.
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Figure 80. File Selection Window

11. In the Project Creation window (see Figure 79), click Finish to complete the project 
creation or click Next to display the Communication Settings window (see 
Figure 81). The Communication Settings window displays the communication 
parameters for the project.

12. In the Communication Settings window, select the appropriate communication type 
and enter the communication parameters. You have the option to change these 
parameters at a later time using the Communication link under the Project tab of the 
Workspace window. See Communications Window on page 22 

13. Click Finish to complete the creation of the project.
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Figure 81. Communication Settings Window

Create a Target Device 

This section describes the procedure for creating a target device for eZ80Acclaim!® and 
Z8 Encore!® family of processors.

New Target Wizard for eZ80Acclaim!® Family of Processors

The following steps helps you to create a new target device for eZ80Acclaim!® family of 
processors. 

1. In the Target Selection section of the Project Creation window (see Figure 79), 
double-click <New Target>.

If the Project Creation window is not displayed, enable the advance settings by clicking 
the Advanced Configuration button on the Information window (see Figure 59) and then 
select New Target from the Target menu to create a new target.

The Target Creation window is displayed (see Figure 82)

Note:
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Figure 82. Target Settings for eZ80Acclaim!®

2. Enter a descriptive name in the Target Name text box. The name must be a legitimate 
Windows file name. 

3. Select the Place Target File In Project Directory check box if you want your new 
target file to be saved in the same directory as the currently active project.

4. Click Next.

5. The Target Clock Settings window is displayed (see Figure 83).

6. In the Target Clock Settings window (see Figure 83), the default clock frequency for 
the selected CPU will be displayed in the System clock Frequency text box. You can 
also enter a new appropriate system clock frequency. 
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Figure 83. Target Clock Settings Window for eZ80Acclaim!®

7. Click Next, the Target Memory Settings window will be displayed. Enter the 
appropriate values for the target memory settings. For details, see Memory Window 
on page 31. 

8. Click Next, the Target Flash Memory Settings window will be displayed. Select the 
Flash memory device that you want to program and enter the appropriate settings. You 
have the option to change the settings later using the Flash memory link under the 
Target tab of the Workspace window. For details, see Flash Memory Window on 
page 32.
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9. Click Next, the Target Summary (see Figure 84) window will be displayed. The 
Target Summary (see Figure 84) window provides a summary of all your selections 
made during the creation of a target device. 

If it is required to change a target setting, click Back until you reach the appropriate 
Target Setting window.

10. Click Finish.

The ZdsFlash:Project Creation window (see Figure 79) reappears. The target you 
have created will be highlighted in the Target Selection list.

11. On the Project Creation window (see Figure 79), click Finish to complete the project 
creation. 

Figure 84. Target Summary Window for eZ80Acclaim!®
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Clicking the Cancel button in the Project Creation window (see Figure 79) will cancel the 
project creation. However the new target created will not be deleted and will be available 
for use later.

New Target Wizard for Z8 Encore!® Family of Processors 

The following steps helps you to create a new target device for Z8 Encore!® family of 
processors. 

1. In the Target Selection section of the Project Creation window (see Figure 79), 
double-click <New Target>.

The Target Creation window is displayed (see Figure 85).

If the Project Creation window is not displayed, enable the advance settings by clicking 
the Advanced Configuration button on the Information window (see Figure 59) and 
then select New Target from the Target menu to create a new target.

Figure 85. Target Settings for Z8 Encore!®

2. Enter a descriptive name in the Target Name text box. The name must be a legitimate 
windows file name. 

3. Select the Place Target File In Project Directory check box if you want your new 
target file to be saved in the same directory as the currently active project.

4. Click Next.

5. The Target Clock Settings window is displayed (see Figure 86).

Note:

Note:
UM020001-0406 Configuration



Smart Flash Programmer
User Manual

44
Figure 86. Target Clock Settings Window for Z8 Encore!®

6. In the Target Clock Settings window (see Figure 86), the default clock frequency for 
the selected CPU will be displayed in the System clock Frequency text box. You can 
also enter a new appropriate system clock frequency. 

7. Click Next, the Target Summary window (see Figure 87) displays the summary of 
all your selections made during the creation of a target device. 

Figure 87. Target Summary Window for Z8 Encore!® 

If it is required to change a target setting, click Back until you reach the appropriate 
Target Setting window.

8. Click Finish when you have completed setting up the target.
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The Project Creation window (see Figure 79) reappears. The target you have created will 
be highlighted in the Target Selection list.

9. On the Project Creation window (see Figure 79), click Finish to complete project 
creation. 

Project creation can be cancelled by clicking the Cancel button on the Project Creation 
window (see Figure 79). However the new target created will not be deleted and will be 
available for use at a later time.

Note:
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Chapter 4 
Programming Flash Memory

This chapter describes a Flash programming workflow under the following topics: 

• Introduction 

• Program Flash on an Attached Target  

• Fast Program Flash on an Attached Target 

• Verify Program Stored in Flash on an Attached Target 

• Erase Flash on an Attached Target 

• Program a Single Value in Flash on an Attached Target 
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Introduction

The instructions in this section describe a suggested Flash programming workflow for 
manufacturing use. 

The following instructions gives you the basic steps for using SFP:

1. Connect your manufacturing PC to the target board using a ZiLOG Smart cable. 

If you wish to program multiple target programming using USB or Ethernet, select all 
the target devices to be programmed and connect them to the USB or Ethernet hub. 

Refer your manufacturing test instructions for connection details.

2. Start the SFP and load the correct Flash project file.

3. Flash the target board.

4. Disconnect the target board and connect another.

Program Flash on an Attached Target

The following steps describes the procedure for programming Flash on a target device 
with the currently open project file and automatically verify the Flash program:

1. Connect your manufacturing PC to the target board containing the target device to be 
programmed using serial or USB or Ethernet cable as appropriate. If you wish to 
program multiple targets using USB or Ethernet, connect the targets to USB or 
Ethernet hub. 

2. Open the File menu and click Open Project. The Project File Selection window (see 
Figure 35) is displayed. Select the project file to be programmed, and click Open.
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Figure 35. Project File Selection Window

3. Click Program/Verify  

If you are programming multiple targets using Ethernet/USB, select all the target IP 
addresses/serial numbers in the Communication window under the Project tab of the 
Workspace window (see Figure 66 and Figure 67).

The Flash Burn window (see Figure 36) is displayed indicating the status of Flash 
programming.
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Figure 36. Flash Burn Window 

The Flash Burn window (see Figure 36) indicates programming and verification 
status. If verification fails, the Flash Burn window (see Figure 36) indicates the file 
that failed and its associated memory location.

4. When the Status window (see Figure 77) indicates that verification is complete, 
disconnect the target board and connect a new target board.

5. Repeat Steps 2 through 4.

Fast Program Flash on an Attached Target

The Fast Program option programs Flash on a target device with the open project file 
without verification. The following steps describes the procedure for fast programming 
Flash on a target device:

1. Connect your manufacturing PC to the target board containing the target device to be 
programmed using serial or USB or Ethernet cable as appropriate. If you wish to 
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program multiple targets using USB or Ethernet, connect the targets to USB or 
Ethernet hub. 

2. Open the File menu and click Open Project. The Project File Selection window (see 
Figure 35) is displayed. Select the project file to be programmed, and click Open.

3. Click Fast Program  

If programming multiple targets using Ethernet/USB, select all the target IP addresses/
serial numbers in the Communication window under the Project tab of the 
Workspace window (see Figure 66 and Figure 67).

A Flash Burn window (see Figure 36) is displayed indicating the status of Flash 
programming. 

4. When the Status window (see Figure 77) indicates that programming is complete, 
disconnect the target board and connect a new target board.

5. Repeat steps 2 through 4.

Verify Program Stored in Flash on an Attached Target

To verify the program stored in Flash on an attached target:

1. Connect your manufacturing PC to the target board containing the target device to be 
programmed using serial or USB or Ethernet cable as appropriate. If you wish to 
program multiple targets using USB or Ethernet, connect the targets to USB or 
Ethernet hub. 

2. Open the File menu and click Open Project. The Project File Selection window (see 
Figure 35) is displayed. Select the project file to be verified, and click Open.

3. Click Verify 

For verifying multiple targets using Ethernet/USB, select all the target IP addresses/serial 
numbers in the Communication window under the Project tab of the Workspace 
window (see Figure 66 and Figure 67).
UM020001-0406 Programming Flash Memory



Smart Flash Programmer
User Manual

52
Figure 37. Flash Verify Window

The Flash Verify (see Figure 37) window displays the status of verification. If verification 
process fails, this window displays the failed file name and associated memory location.

Erase Flash on an Attached Target

Writing 1s to all memory locations is considered erasing Flash memory. To set all bits in 
Flash memory on an attached target to 1:

1. Connect your manufacturing PC to the target board containing the target device to be 
programmed using serial or USB or Ethernet cable as appropriate. If you wish to 
program multiple targets using USB or Ethernet, connect the targets to USB or 
Ethernet hub. 

2. Open the File menu and click Open Project. The Project File Selection window (see 
Figure 35) is displayed. Select the project file to be erased, and click Open.

3. Click Erase 
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The Question window (see Figure 38 and Figure 39) is displayed. 

Figure 38. Question Window for Z8 Encore!®

Figure 39. Question Window for eZ80Acclaim!®

4. In the Question dialog window (see Figure 38 and Figure 39), click Yes to erase and 
No to cancel the erase operation.

For erasing multiple targets using Ethernet/USB, select all the target IP addresses/serial 
numbers in the Communication window under the Project tab of the Workspace 
window. (see Figure 66 and Figure 67).

The Flash Erase window (see Figure 40) is displayed indicating the status of erasing.
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Figure 40. Flash Erase Window

Program a Single Value in Flash on an Attached Target

The Program Single Value option is a serialization feature that programs a single unique 
value into Flash memory on an attached target. Before programming a single value, ensure 
that serialization values for address and byte size are properly configured.

To program a single unique value into Flash on an attached target:

1. Ensure the target is properly connected to the manufacturing PC.

2. Click Single Value 

The Program Single Value window (see Figure 41) is displayed.
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Figure 41.  Program Single Value Window

3. In the Program Single Value window (see Figure 41), enter a value in the Value text 
box and select the format (Hexadecimal, Decimal, IP Address, or MAC Address) of 
entry for the value to be programmed.

4. Click Program Value.

The value you entered is programmed into Flash memory on the attached target at the 
memory location specified in the serialization settings. The status of initializing 
communication and gathering information is displayed in Figure 42 and Figure 43. 

Figure 42. Initializing Communication Window
UM020001-0406 Programming Flash Memory



Smart Flash Programmer
User Manual

56
Figure 43. Gathering Information Window

You can also read the value programmed in the attached target. To do so, ensure that the 
target is attached and click Read Value. The SFP returns the value of the data stored in the 
location defined by the serialization settings.
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Chapter 5 
Advanced Configuration

This chapter describes the Advanced Configuration window under the following topics:

• Advance Configuration

• Calculate File Checksum

• Calculate Flash Checksum

• Specify the Flash Files to be Programmed

• Set-Up Serialization 

• Manage Targets 
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Advance Configuration

In the Information window of the SFP, click Advance Configuration button to enable 
the advanced configuration interface.

Figure 44. Advanced Configuration Window

The Advanced Configuration window allows you to:

• Calculate the checksum for a specific hex file (Flash menu).

• Specify Flash Files to be programmed (Project tab).

• Specify Flash File offsets (Project tab).
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• Configure Serialization (Project tab).

• Change communication settings (Project tab).

• Change the target system clock settings (Target tab).

See Information Window for detailed description of the above features.

Flash files are not required for serialization-only operations.

Calculate File Checksum

Follow the steps below to calculate the checksum of a hex file to be loaded into Flash 
memory. Observe the checksum value before you use a Flash file, so that you can make 
sure that the file has not changed since the last time you used it.

1. From the Flash menu, select File Checksum. The File Checksum Calculator 
window is displayed (Figure 45).

Figure 45. File Checksum Calculator Window

2. Click browse  button.

Select a File for Checksum Calculation window (Figure 46) is displayed.

Note:
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Figure 46. Select File For Checksum Calculation Window

3. In the Select a File for Checksum Calculation window (Figure 46), select the hex 
file and click Open.

4. In the File Checksum Calculator window (Figure 45), click Calculate.

The checksum for the selected hex file is calculated.

Calculate Flash Checksum

Follow the steps below to calculate the Flash Checksum for the selected target. Observe 
the Flash checksum and compare it with the file checksum to verify whether the target 
flash has the same contents as the files mentioned in the project.

1. From the Flash menu, select Flash Checksum.
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2. Based on the Communication type selected in the Communication window under the 
Project tab. See Communications Window on page 22, one of the Flash Checksum 
Calculator window (Figure 47 or Figure 48) is displayed. If serial type of 
communication is selected, Figure 47 is displayed and if USB or Ethernet type of 
communication is selected, Figure 48 is displayed.

Figure 47. Flash Checksum Calculator for Serial Type of Communication

3. The File Checksum Details pane of the Flash Checksum Calculator window 
(Figure 47 or Figure 48), displays all the hex files included in the project for 
programming along with their individual checksum. It also displays the total file 
checksum of all the files included in the project.
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Figure 48. Flash Checksum Calculator for Ethernet/USB Type of Communication

4. In case of serial communication type, click Calculate Checksum button and in case 
of Ethernet or USB communication type, select the target IP address/serial number 
(see Communications Window on page 22), and then click Calculate Checksum 
button. 

SFP reads all the memory locations from the Flash pertinent to the addresses found in 
the hex files and displays the final checksum. The Flash checksum will be the same as 
the file checksum if the Flash contents and the file contents are same.

Specify the Flash Files to be Programmed

Follow the steps below for programming hex files into the target device.

1. On the Workspace window, under the Project tab, click Flash Files link. The Flash 
File window (Figure 49) is displayed. For detailed description of the Flash files, see 
Flash Files Window . 
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Figure 49. Flash Files Window

2. In the Flash Files Programming Order section on the Flash Files window 
(Figure 49), click Add.

Select Files to be Programmed window is displayed (Figure 50).

3. Browse to the folder containing the Flash file(s) you want to program. Select a file, 
and click Open.

The Flash file selected will be displayed in the Programming Order section of the 
Flash Files window (Figure 49).

4. Repeat step three for each Flash file to be programmed.

You can change the programming order of the Flash file using the Up or Down button. 
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Figure 50. File Selection Window

Set-Up Serialization

See Serialization Window on page 25.

Manage Targets

Follow the steps below for managing the available target configurations.

1. On the Target menu, select Manage Targets.The Target Manager window 
(Figure 51) is displayed.
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Figure 51. Target Manager

From the Target Manager window, you can perform the following tasks.

2. To create a target, click New Target and follow the instructions given in Create a 
Target Device on page 39.

3. To rename a target:
–  Select a target and click Rename. 

Name the New Target window (Figure 52) is displayed.

Figure 52. Name the New Target Window

– In the Name the New Target window (Figure 52), enter the new name for the 
target and click OK, the target name changes.

You can also use the browse button to locate the new target
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You cannot rename an active target.

4. To copy a target configuration to a new target:
– Select the target you wish to copy and click Copy. Name the New Target win-

dow (Figure 52) is displayed.
– Enter the name for the new target and click OK.The new target appears in the 

Target Selection list of the Target Manager window (Figure 51).

5. To delete a target configuration:
– Select the target you wish to delete and click Delete. The system prompts you to 

confirm the deletion.

• Select Yes to confirm deletion, or No to cancel.

You cannot delete an active target.

6. To set active target configuration:
– Select the target that you wish to set as active and click Set Active.

The system sets the selected target as an active target. Double-clicking the target also 
sets the target as an active target.

7. To import a target
– Click Import. Import Target Window (Figure 53) is displayed.

Figure 53. Import Target Window

– In the Import Target window (Figure 53), enter the target file path and file name. 
You can also use the Browse button to locate the new target. The target files will have 

the extension: .ztgt.
– Once the target is selected, you can click Show Details to view the details of the 

selected target.
– Click OK to import the target. The imported target file will be copied to the 

appropriate family directory at <installation_dir>/targets.

• The CPU family group of the target being imported should match with the active CPU 
family group for the import process to be successful.

Note:

Note:

Notes:
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• If the CPU family of the target being imported differs from the CPU family of the 
active target, but both belonging to the same CPU family group, the import operation 
will be successful. However, such a target will not be listed under the available targets 
for the current active configuration.

• The target file being imported must be a valid target file and must have the 
extension.ztgt. Otherwise the import process will fail.
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Chapter 6 
SFP Command Line and Scripting 
Features

This chapter describes the SFP command line and scripting features under the following 
topics:

• Starting SFP from Command Prompt 

• SFP Scripting 

• Command Script File 

• Supported Script File Commands 

• Project Related Commands 

• Target Related Commands 

• Communication Settings 

• Error Handling 

• Miscellaneous Commands 
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Starting SFP from Command Prompt

You can start SFP from an Windows command prompt and use command prompt switches 
to specify the display options.

Command Syntax
C:\[installation_path]\bin\zdsflash [<project_file>]|[-s] [-l] 
[<log_file>][-h] [-dl] [-b] [<script_file>]

Switches                                             

• <project_file> – Specify a project file name to load. 
• -s – Cause the SFP to display the project selection dialog on startup. 
• -l <log_file> – Change the name of the default log file created for the new 

session. 

• -h – Display a usage summary for the SFP command line launch options.

• -dl - Disable logging.

• -b <script_file> -   Run the script file.

For example, to load the project file c:\flash_files\my_project.zfpproj from 
the command line, enter:
C:\[installation_path]\bin\zdsflash C:\flash_files\my_project.zfpproj

SFP Scripting

The SFP scripting feature allows you to use script files to automate the execution of a 
significant portion of the SFP’s functionality.

You can run the script file commands in one of the following ways:

• Using the command prompt.You need to precede the script file with a switch -b when 
passing the command file to the SFP on the command line. For example:
zdsflash -b "c:\path\to\command\file\runall.zfpscr

• Using the Run Script File option from the File menu.

Commands and associated results are displayed in the status window in SFP and also 
saved into the log files if logging feature is enabled.
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Command Script File

A script file is a text-based file with a collection of commands. The file can be created 
with any editor that can save or export files in a text-based format. Each command must be 
listed on its own line. Anything following a semicolon (;) is considered a comment.

Command Syntax
C:\[installation_path]\bin\zdsflash [-b][<script_file>]

Switches

<script_file> – Specify a project file name to load

For example: To run a script file "test.zpfscr" from the command line, use the 
following syntax: 
C:\Program Files\ZiLOG\ZiLOG SFP_2.0.0\bin>zdsflash -b"test.zpfscr"

Supported Script File Commands

Table 3 lists SFP menu commands and dialog box options that have corresponding script 
file commands.

Table 3. Script File Commands  

SFP 
Menu

SFP 
Commands

Dialog Box 
Options

Script File Command Target Page

File New Project new project "<name>" 
"<target>" [NOREPLACE]

All Page 78

Open Project open project 
"<Project_Name>"

All Page 79

Save Project save project All Page 79
SaveAs 
Project

saveas project "<Destname>" All Page 79

Clear Log clear log All Page 80
Exit exit All Page 80

Flash Program/Verify Flash burnverify All Page 85
Fast Program Flash burn All Page 84
Verify Flash verify All Page 85
Erase Flash erase All Page 84
Single Value Flash programhex "<Hex>" All Page 85
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Flash programdec "<Dec>" All Page 85
Flash programIPaddr 
"<IPAddress>"

All Page 85

Flash programmacaddr 
"<MacAddress>"

All Page 85

Read Value Flash readvalue All Page 85
Flash 
Checksum

Flash checksum All Page 85

Target Manage Target

Rename target rename 
srcname="<source target 
name>"newname="<new 
target name>"

All Page 82

Copy target copy destname="<new 
target name>" 
srcname="<new target 
name>"

All Page 82

Delete target delete "<target name>" All Page 82
Selection target list All Page 82

Save Target target save All Page 82

New target Target Create TargetName = 
"<targetName>" FAMILY 
="<family>" CPU ="<cpu>" 
[NOREPLACE]

All Page 81

Target settings 
page 
(communicatio
n settings 
category)

Type target options Commtype = 
<ethernet/serial/USB>

All Page 81

Type Serial target options Commtype  
=Serial

All Page 81

Port target options serialport 
=<Port Number>

All Page 81

Table 3. Script File Commands  (Continued)

SFP 
Menu

SFP 
Commands

Dialog Box 
Options

Script File Command Target Page
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Baud rate target options Serialbaud 
=<Baudrate>

All Page 81

Use alternate 
ZDI clock 
frequency

target options Altclk =<True/
False>

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Type Ethernet target options Commtype  = 
Ethernet

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

ADD Comm.AddTCP IPaddr= 
<"IPaddr"> 
TCPIPport<Portnum>

eZ80® and 
eZ80Acclaim!® 
families 

Page 83

Delete Comm DeleteTCP 
IPaddr="<IPaddr>"

eZ80® and 
eZ80Acclaim!® 
families 

Delete all Comm DeleteAllTCP eZ80® and 
eZ80Acclaim!® 
families 

Page 83

Select IP 
address

Comm SelectTCP IPaddr = 
"<IPaddr>"

eZ80® and 
eZ80Acclaim!® 
families 

Page 83

Deselect IP 
Address

Comm DeselectTCP IPaddr = 
"<IPaddr>"

All Page 83

Type USB target options Commtype = 
USB

All Page 81

Select USB Comm SelectUSB 
"<UsbserialNo>"

All Page 84

Deselect USB Comm DeselectUSB 
"<UsbserialNo>"

All Page 84

Target clock 
settings page

System clock 
frequency

target options 
Clk="50000000"

All Page 81

Table 3. Script File Commands  (Continued)

SFP 
Menu

SFP 
Commands

Dialog Box 
Options

Script File Command Target Page
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Clock source 1. target options IntClk
//Clock source internal
2. target options ExtClk
// Clock source external

Z8 Encore!® 4k 
series 

Page 81

Target memory 
settings page 
(External 
memory)

Bound Upper 
(CS0)

target options CS0UPR = 
"10"

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Bound Lower 
(CS0)

target options CS0LWR ="10" eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Control 
Register 
(CS0)

target options CS0CTL ="10" eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Bus mode 
(CS0)

target options CS0BUS ="10" eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Bound Upper 
(CS1)

target options CS1CTL ="10" eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Control 
Register 
(CS1)

target options CS1CTL ="10" eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Bus mode 
(CS1)

target options CS1BUS ="10" eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Bound Upper 
(CS2)

target options CS2CTL ="10" eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Control 
Register 
(CS2)

target options CS2CTL ="10" eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Table 3. Script File Commands  (Continued)

SFP 
Menu

SFP 
Commands

Dialog Box 
Options

Script File Command Target Page
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Bus mode 
(CS2)

target options CS2BUS ="10" eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Bound Upper 
(CS3)

target options CS3CTL ="10" eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Control 
Register 
(CS3)

target options CS3CTL ="10" eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Bus mode 
(CS3)

target options CS3BUS ="10" eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Ram address 
range (lower)

target options RAMLOWER 
="B7E000"

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Ram address 
range (upper)

target options RAMUPPER 
="B7FFFF"

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Target Memory 
settings page 
(category 
internal 
memory)

Enable Data 
Ram

target options 
DATARAM=<TRUE/FALSE>

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Enable EMAC 
RAM

target options 
EMACRAM=<TRUE/FALSE>

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Address 
Upper byte

target options ADDRU ="FF" eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Flash 
Address 
Upper byte

target options FLASHUPR 
="FF"

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Table 3. Script File Commands  (Continued)

SFP 
Menu

SFP 
Commands

Dialog Box 
Options

Script File Command Target Page
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Target Flash 
memory 
settings page

Use internal 
flash(internal 
falsh memory)

1. Flash options INTMEM
//Set to internal memory
2. Flash options EXTMEM
//Set to external memory
3. Flash options BOTHMEM
//Set to internal and external 
memory

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

External flash 
memory

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Micron(MT28 
F008B3xx-
xxB)

Flash options MANUF 
="MICRON" DEVICE 
="MT28F008B3xx-xxB"

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Micron(MT28 
F008B3xx-
xxT)

Flash options MANUF 
="MICRON" DEVICE 
="MT28F008B3xx-xxT"

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

AMD(AM29LV
160BB)

Flash options MANUF 
="AMD" DEVICE 
="AM29LV160BB"

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

AMD(AM29LV
160BT)

Flash options MANUF 
="AMD" DEVICE 
="AM29LV160BT"

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

AMD(M29W0
08AB)

Flash options MANUF 
="STMICRO" DEVICE 
="M29W008AB"

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

AMD(M29W0
08AT)

Flash options MANUF 
="STMICRO" DEVICE 
="M29W008AT"

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Atmel(AT49B
V162A)

Flash options MANUF 
="ATMEL" DEVICE 
="AT49BV162A"

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Atmel(AT49B
V162AT)

Flash options MANUF 
="ATMEL" DEVICE 
="AT49BV162AT"

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Table 3. Script File Commands  (Continued)

SFP 
Menu

SFP 
Commands

Dialog Box 
Options

Script File Command Target Page
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Custom(MT2
8F008B3 w/
jmp vectors)

Flash options MANUF 
="CUSTOM" DEVICE 
="MT28F008B3 w/jmp 
vectors"

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

External 
Flash base 
address

target options 
EXTERNALADDR="FFFEE"

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Number of 
units

target options 
UNITS=<NUMBER>

eZ80® and 
eZ80Acclaim!® 
families 

Page 81

Project tab 
(Flash files 
item)

Add target add file "<hex file>" All Page 80

Remove target remove file "<hex file>" All Page 80
Project tab 
(settings item)

File 
offset(hex)

Flash options OFFSET 
="<address>"

All Page 81

Erase before 
programming

Flash options EBF /*Erase*/
Flash options NEBF /*Do not 
erase*/ 

All Page 81

Do not erase 
info page

Flash options EIP /*Erase*/
Flash options NEIP /*Do not 
erase*/ 

eZ80® and 
eZ80Acclaim!® 
families

Page 81

Project 
tab(Serializatio
n item)

Include 
serialization in 
programming

Flash options ISN /*Include*/
Flash options NISN /*Not 
include*/ 

All Page 81

Place in info 
NVDS

Flash option NVDS
Flash options NNVDS

Z8 Encore!® Page 81

Place in info 
page

Flash options IP
Flash options NIP

eZ80® and 
eZ80Acclaim!® 
families

Page 81

Address Flash options 
SERIALADDRESS 
="<address>"

All Page 81

Size in bytes Flash options SERIALSIZE 
=<1-8>

All Page 81

Table 3. Script File Commands  (Continued)

SFP 
Menu

SFP 
Commands

Dialog Box 
Options

Script File Command Target Page
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• Commands are not case sensitive.

• In directory or path-based parameters, you can use \, \\, or / as separators as long as 
you use the same separator throughout a single parameter.

The following example are legal:

cd "..\path\to\change\to"

cd "..\\path\\to\\change\\to"

cd "../path/to/change/to"

The following examples are illegal:

cd "..\path/to\change/to"

cd "..\\path\to\change\to"

Project Related Commands

New Project
The new project command creates a new project designated by project_name, target, 
and the type provided. If the full path is not provided, the current working directory is 
used. By default, existing projects with the same name are replaced. Use NOREPLACE  
to prevent the overwriting of existing projects. 

Syntax:
new project "<name>" "<target>"  [NOREPLACE]

Serialization 
value

Flash Option SERIALVALUE 
=< " ">

All Page 81

Serial entry 
type

Flash Option SERIALENTRY 
=<Decimal/Hexa/MACAddr/
IPAddr>

All Page 81

Increment 
setting

Flash options INCREMENT = 
"<Decimal value>

All Page 81

Program 
serial

Flash BURNSERIAL All Page 85

Read Serial Flash READSERIAL All Page 85

Table 3. Script File Commands  (Continued)

SFP 
Menu

SFP 
Commands

Dialog Box 
Options

Script File Command Target Page

Notes:
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Examples:
new project "test1.zdsproj" "eZ80ContestKit_F91"

new project "test1.zdsproj" "eZ80ContestKit_F91" NOREPLACE

Open Project
The open project command opens the project designated by project_name. If the full path 
is not supplied, the current working directory is used. The command fails if the specified 
project does not exist. 

Syntax:
open project "<project_name>"

Examples:
open project "test1.zfpproj"

open project "c:\projectsest1.zfpproj" 

Save Project
The save project command saves the project that is open. 

Syntax:
save project 

Examples:
save project 

//new project "test1.zdsproj"

Saveas Project
The saveas  command copies Srcname to the project name specified by Destname.

Syntax:
saveas project  "<Destname>" 

<name> Name of the new project.
<target> Must match one of the previously created targets.

Use target list command to list out all the previously created targets.
The target created is saved in a target file.

[NOREPLACE] Optional parameter to prevent overwtiting of the existing project.

<Destname> Destination Name.
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Examples:
saveas project "test1.zdsproj" 

Clear Log
Clears the log file

Syntax:
clear log 

Example:
clear log

Exit

The exit command exits the SFP.

Syntax:
exit

Add File

The add file command adds the hex file to be programmed on the target. If the full path is 
not provided, the current working directory is used. 

Syntax:
target add file "<hex file>"

Example:
target add file "blah.hex"

Remove File
The remove file command removes the given file from the currently open project. If the 
full path is not provided, the current working directory is used. 

Syntax:
target remove file "<hex file>"

Example:
target remove file "blah.hex"
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Flash Options Settings

The various Flash options are listed below:
      

Target Related Commands

Target Create
The target create command creates a target.

Syntax:
Target Create TargetName = "<targetName>" FAMILY ="<family>" CPU 

="<cpu>" [NOREPLACE]

NOREPLACE optional parameter to overwrite the existing target

Target Options
Syntax:
Target Options <option name>
Target Options <option name>="<value to set>"

Syntax Description
Flash Options Offset = "<address>" Offset address in hex file
Flash Options NEBF   Do not erase before flash
Flash Options EBF  Erase before flash
Flash Options NISN   Do not include serial number
Flash Options ISN  Include a serial number
Flash Options NVDS    Place in NVDS
Flash Options NNVDS         Not Place in NVDS
Flash Options INTMEM  Set to internal memory
Flash Options SERIALADDRESS = 
"<address>"

Serial number address

Flash Options SERIALENTRY 
=<DECIMAL/HEXA/MACADDR/IPADDR>

Sets the serial value entry(Decimal, 
Hexadecimal, Macaddress, 
IPaddress)

Flash Options SERIALVALUE =<" "> Sets the serial value to be 
programmed

Flash Options SERIALSIZE = <1-8> Number of bytes in serial number
Flash Options INCREMENT = "<Decimal 
value>"

Increment value for serial number
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Target Set
Sets the target name as active target

Syntax:
Target Set "<Target Name>"

Target Copy
The target copy command copies Srcname to the target name specified by Destname. 

Syntax:
TargetCopy DestName = "<New Target Name>" Srcname = "<New  Target 
Name>"  [NOREPLACE]

NOREPLACE optional parameter to overwrite the existing target

Target Save
The target save command saves the configuration for the target TargetName. If no target 
specified, currently selected target for the project is used

Syntax:
target save "<TargetName>"

Target Delete
The target delete command delete the target TargetName. 

Syntax:
target delete "<TargetName>"

Target Rename
The Target rename command renames target Srcname to the new target name specified by 
Destname. 

NOREPLACE optional parameter to overwrite the existing target.

Syntax:
Target rename SRCNAME = "<SOURCE Target Name>"  NEWNAME = "<New  
Target Name>"  [NOREPLACE]

Target List
Displays list of all currently created targets.

Syntax:
target list

Example:
target list
SFP Command Line and Scripting Features UM020001-0406



Smart Flash Programmer
User Manual

83
Communication Settings

The communication settings command allows you to select the target communication 
type. In case of Ethernet and USB type of communication, the communication settings 
command allows you to manage the targets connected to different communication points. 
You can  add, delete, select, and deselect the communication points.  These commands 
would be useful in multiple target programming.

In case of serial communication, the communication settings command allows you to set 
the port number and baud rate for the device connected.

Serial Settings 
target options CommType = Serial

Ethernet Settings
target options COMMTYPE = TCPIP

Comm  AddTCP 
The Comm AddTCP  command adds an IPAddress to the debug tool list.

Syntax:
Comm AddTCP IPaddr = <" "> TCPIPport<" ">

Comm  DeleteTCP  IPaddr = <" ">
The Comm DeleteTCP command deletes an IPAddress from the debug tool list.

Syntax:
Comm DeleteTCP IPaddr = <" ">

Comm   DeleteAllTCP       
The Comm DeleteAllTCP  command deletes all IPAddress from the debug tool list.

Syntax:
Comm  DeleteAllTCP    

Comm  SelectTCP       
The Comm SelectTCP  command selects an IPAddress for the multiple target 
programming.

Syntax:
Comm SelectTCP    IPaddr = <" ">
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Comm  DeselectTCP                 
The Comm DeselectTCP   command deselects the IPAddress which is already selected for 
the multiple target programming.

Syntax:
Comm  DeselectTCP           

USB Settings
target options CommType = USB

Comm  SelectUSB      
The Comm SelectUSB  command selects an USB for the multiple target programming.

Syntax:
Comm  SelectUSB           

Comm  DeselectUSB     
The Comm DeselectUSB command deselects the USB which is already selected for the 
multiple target programming.

Syntax
Comm DeselectUSB

Flash Operations

Erase Flash
Erase Flash memory

Syntax:
Flash Erase [Repeat] 

Repeat optional parameter to repeat the command.

Set optional parameter to be used for multiple target programming.

Using Repeat option: After execution of the command, a message box is displayed, 
which waits for the user input. The user can disconnect and connect new set of target/
targets.

Burn Flash
Burn Flash memory

Syntax:
Flash Burn [Repeat] 

Note:
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Burn and Verify Flash 
Burn and verify Flash memory

Syntax:
Flash BurnVerify [Repeat] 

Verify Flash 
Verify Flash memory

Syntax:
Flash Verify [Repeat] 

Burn Serial 

Burn the serial number

Syntax:
Flash BurnSerial [Repeat] 

Read Serial
Read the serial number

Syntax:
Flash ReadSerial [Repeat] 

Program Single Value  
Program a single value in Flash on an attached target

Syntax:
Flash ProgramHex  "<Hex>"  
Flash ProgramDec  "<Dec>"  
Flash ProgramIPaddr "<IP address>"  
Flash ProgrammMacaddr "<MAC ADDRESS>" 

Read Single value  
Read the value programmed into the attached target

Syntax:
Flash ReadValue

Calculate checksum 
Calculates the Flash checksum for the target

Syntax:
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Flash checksum   

Error Handling

Scripting provides the following command to handle errors while executing commands.  
The default behavior is to exit from the scripting mode, when an error is encourted. 

Syntax:
command_error [<Continue/Discontinue>]

This command specifies the action on executing command:
command_error [CONTINUE]

Continues with the execution of next command.
command_error [DISCONTINUE]

Stops executing commands when it encounters the error.

Miscellaneous Commands

Pwd  
The pwd command retrieves the current working directory.

Syntax:
pwd

Example:
pwd

Cd 
The cd command changes the working directory to dir. 

Syntax:
cd   "<dir>"

Examples:
cd "c:emp"

Batch
The batch command runs a script file through the Command Processor.  If the full path is 
not provided, the current working directory is used.

Syntax:
batch "<filename>"
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Examples:
BATCH "commands.txt"
batch "d:\batch\do_it.cmd"

Log 
The log command sets the given file as the default log file.

Syntax:

The log command can take one of three forms:
log "<filename>" 

Sets the file name as the default log file. 
log on

Activates the log.
log off

Deactivates the log.

Examples:
log "buildall.log"
@log on
@log off
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Appendix A—Files Used by SFP
SFP uses three different files for storing the data:

Debug Tool Files: Stores all the communication details. SFP uses three debug tools: 
serial, USB and Ethernet. SFP saves all the debug tool related information in a separate 
file. These files are saved in common repository at <installation_dir>/debug 
tools directory. Any changes made to debug tools in one project will reflect other 
projects also.

Target Files: The target file stores all the target details. The target file is also stored in the 
default directory at <installation_dir>/targets. 

Project File: The project file stores all the project details. The location of storing the 
project file is user specific. 
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Appendix B—Example Script
The example given below illustrates the script commands for the following requirement

1. Create target for eZ80Acclaim!® family.

2. Setting the target options.

3. Creating a new project for the above target.

4. Adding Flash files to be programmed.

5. Adding a set of targets which are on network.

6. Program all these targets. 

7. Repeat programming for the new set of targets.

// Create target
 target create TargetName ="targetf91_ether_101101" 
FAMILY="ez80Acclaim!" CPU="ez80F91" CommType=Ethernet

// Settings the target options 
 target Options RAMLower="000000"
 target Options RAMUpper ="03FFFF"
 target Options CS0LWR = "04"
 target Options CS0UPR = "7F"
 target Options CS0CTL = "E8"

// Create Project
new project "F:\Projects\proj_ether101101.Zfpproj"         
"targetf91_ether_101101"

// Adding files
 add file "C:\samples\ledDemo1.hex"
 add file "C:\samples\ledDemo2.hex"

// Adding communication points
Comm AddTCP IPaddr="172.16.6.231" TCPIPport=4040
Comm AddTCP IPaddr="172.16.6.232" TCPIPport=4040
Comm AddTCP IPaddr="172.16.6.233" TCPIPport=4040
Comm AddTCP IPaddr="172.16.6.234" TCPIPport=4040
COMM AddTCP IPaddr="172.16.6.235" TCPIPport=4040
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// The repeat option displays a message box, waiting for the user i/p to 

// repeat the programming. The user can connect new set of targets to 

// above IP address and presses OK button to repeat the programming

flash burn repeat
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Customer Support
If you experience any problems while operating this product, please 
check the ZiLOG Knowledge Base:

http://kb.zilog.com/kb/oKBmain.asp

If you cannot find an answer or have further questions, please see the 
ZiLOG Technical Support web page:

http://support.zilog.com
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F
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M
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